Microsoft Access 2010
Basics & Database Fundamentals
Microsoft Access is a relational database application. It’s the perfect tool when you begin to outgrow your data collection in Excel. With Access you can obtain better collection results by creating user-friendly forms with rules to protect the validity of your data. You can create queries to analyze and filter your data, and reports that can be regenerated anytime you need them. Topics for this workshop include database concepts, planning a database, and a hands-on introduction to tables, queries, forms and reports. This workshop is a prerequisite for the other Access workshops.

What is a Database? ........................................................................................................................................... 1

Why use Microsoft Access? ................................................................................................................................... 1

Planning the Database ........................................................................................................................................... 2
  Design Rules ...................................................................................................................................................... 2
  Organizing Data .......................................................... ...................................................................................... 2
  No Derived Fields .................................................. ......................................................................................... 2
  Data is broken down into Smallest Logical Parts ............................................................................................... 2
  Descriptive Field Names .................................................................................................................................. 2
  Unique Field Names ........................................................ ..................................................................................... 2
  No Calculated Fields .................................................. ......................................................................................... 2
  Unique Records .................................................................................................................................................. 3

Basic Access Objects .......................................................................................................................................... 3
  Tables .................................................................................................................................................................... 3
  Vocabulary .......................................................................................................................................................... 4
  Queries .................................................................................................................................................................. 4
  Forms .................................................................................................................................................................... 4
  Reports .................................................................................................................................................................. 6
  Example of Grouping ......................................................................................................................................... 6

Class Exercise ...................................................................................................................................................... 7
What is a Database?
A variety of definitions exist for a database; but essentially it's a collection of information. A filing cabinet, a Rolodex, a library card catalog, and even the Internet are all types of databases.

Most often the word "database" is used to describe a collection of related "data" (information) stored on computers. An electronic database should allow you to store, sort, and retrieve data.

You can create simple databases by creating a Word Table or an Excel spreadsheet. These can be used to keep data such as names and addresses.

For example, here we have simple database of our patients:

<table>
<thead>
<tr>
<th>MedRec#</th>
<th>First Name</th>
<th>Last Name</th>
<th>DOB</th>
<th>Doctor</th>
</tr>
</thead>
<tbody>
<tr>
<td>123-456</td>
<td>Jack</td>
<td>Nimble</td>
<td>06/08/72</td>
<td>Edwards</td>
</tr>
<tr>
<td>987-654</td>
<td>Jill</td>
<td>Pail</td>
<td>08/27/65</td>
<td>Lewis</td>
</tr>
<tr>
<td>753-951</td>
<td>Mary</td>
<td>Bluebell</td>
<td>12/08/51</td>
<td>Edwards</td>
</tr>
</tbody>
</table>

Here is a simple database of our doctors:

<table>
<thead>
<tr>
<th>EmpID #</th>
<th>First Name</th>
<th>Last Name</th>
<th>Phone #</th>
</tr>
</thead>
<tbody>
<tr>
<td>999-999</td>
<td>Ken</td>
<td>Edwards</td>
<td>555-1234</td>
</tr>
<tr>
<td>888-888</td>
<td>Laura</td>
<td>Lang</td>
<td>555-4567</td>
</tr>
<tr>
<td>777-777</td>
<td>Yolanda</td>
<td>Lewis</td>
<td>555-7890</td>
</tr>
</tbody>
</table>

Why use Microsoft Access?
Microsoft Access is a "relational" database application. Relational means we can link together sets of data, we can relate the data. We can keep track of the patients, the doctors and when the patients last saw their doctors, what happened at each visit and so on. Access allows us to relate our data, without the repetition that may occur anywhere else.

In an Access database, we can create both of the datasets and link them.

<table>
<thead>
<tr>
<th>MedRec#</th>
<th>First Last</th>
<th>DOB</th>
<th>Doctor</th>
</tr>
</thead>
<tbody>
<tr>
<td>123-456</td>
<td>Jack Nimble</td>
<td>06/08/72</td>
<td>Edwards</td>
</tr>
<tr>
<td>987-654</td>
<td>Jill Pail</td>
<td>08/27/65</td>
<td>Lewis</td>
</tr>
<tr>
<td>753-951</td>
<td>Mary Bluebell</td>
<td>12/08/51</td>
<td>Edwards</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>EmpID #</th>
<th>First Last</th>
<th>Phone #</th>
</tr>
</thead>
<tbody>
<tr>
<td>999-999</td>
<td>Ken Edwards</td>
<td>555-1234</td>
</tr>
<tr>
<td>888-888</td>
<td>Laura Lang</td>
<td>555-4567</td>
</tr>
<tr>
<td>777-777</td>
<td>Yolanda Lewis</td>
<td>555-7890</td>
</tr>
</tbody>
</table>

In Access the data is saved in Tables. As the Tables change, the rest of the Access database will reflect the newest information (i.e. the Queries, Forms and Reports).

Queries show the data in a Table format. A Query can pull from multiple Tables and allow you to limit the records (rows) display by using criteria and showing only the fields (columns) you want. We can find the phone number for Jill Pail's Doctor, and provide Ken Edwards with a list of his patients.

Forms can be created to provide a "user-friendly" side to your database. They are used to view and enter your data in an interactive formatted structure. Forms are also used to make menus and search windows.

Reports are created to print out your data in a formatted structure. They allow you to group and organize your data. They can also be used to create Form letters and mailing labels.
Planning the Database

The most important part of creating a relational database is planning. This can be difficult when you are first learning to use Microsoft Access. Here are some questions that may help:

1. Input - What data do I already have for the database?
2. Output - What information do I want to get out of the database?
3. Process - What do I need to do to get there?

Sometimes it helps to plan the final Reports that you want from your database to see if you already have a method of collecting all the data you want to display. For example, we want to have a chart of how many patients attended their appointments. Do we track the 'cancellations' vs. the 'no shows'? What about the late arrivals and the rescheduled? If we want to differentiate, we need to make sure we are going to collect that data. This is why it's so important to plan everything, to try to predict the "what ifs" that may occur once you have your data collected.

The Tables are the core of your Access database; it's where all the 'data' is truly saved. Tables are essential to using any of the other Access Tools. When planning out your database try to remember the basic design rules for your Tables.

Design Rules

Organizing Data
Once you have an idea of the data you would like to collect, you need to decide how many tables you might want to use to organize the data efficiently. In Excel we might keep several numbered columns to keep track of things, i.e. Medication1, Medication 2..., but in Access we should create a second table to track the numbered fields.

No Derived Fields
By using the relationships between our data sets, we can derive missing data. If we are creating a new appointment for a patient, we only need to put in their Medical Record Number (or other unique identifier). The patient's name, phone number and other information can be derived from the Patient Table.

Data is broken down into Smallest Logical Parts
Pulling fields together in Access is fairly simple; pulling them apart can be very difficult. Think of this as breaking up the data into its smallest sort-able part.

Descriptive Field Names
It's tempting to use abbreviations when we are creating our data tables, but if the title we use is too vague or too abbreviated we may not be able to recall why we created that field. DOB – Date of Birth or Department of Bread? SSN – Social Security Number or Shands System Number?

Unique Field Names
Be sure to differentiate between the field names in each Table. We can have a 'First Name' in our Patient Table and a 'First Name' in our Doctor Table but this can lead to confusion when we try to pull both Tables into one database object, such as a Query.

No Calculated Fields
In Microsoft Excel we can perform our calculations on the same sheet as our data, but a Table in Access is stagnant data, it doesn't change unless you make it change. Access will let you create calculations in Queries, Forms and Reports.
**Unique Records**

It's important that each Table has a way to keep records unique. We can do this by setting one field (column) to be a **Primary Key** field. When a field is set as a Primary Key, Access will not allow any duplication or blanks.

When there is not a unique field in your data set, you can use an AutoNumber. AutoNumbers are incremented or random fields that are always unique, and thus ideal for your primary key.

**Basic Access Objects**

Access consists of four main database objects: Tables, Queries, Forms, and Reports. Each object has at least two views, Design and Data. The **Design View** is where we build the structure of that database object. The data view is different for each object. Tables and Queries have a **Datasheet View**, Forms have a **Form View**, and Reports have a **Report View**, or a **Print Preview** view.

**Tables**

Tables store data. The Tables are the true 'database' (base of data). These need to be created and properly linked (related) in order to effectively use the other Access tools. Tables are the core of your database, everything else in Access depends on the Tables.

The **Design View** of a Table allows you to create and modify:

- **Field Names** (the column headings)
- The type of data stored in a field (**Data Type**). In this workshop we use:

<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text</td>
<td>Allows any alphanumeric characters, up to 255 characters</td>
</tr>
<tr>
<td>Number</td>
<td>Limited to Numbers only</td>
</tr>
<tr>
<td>Date/Time</td>
<td>Allows Dates and/or Times only</td>
</tr>
<tr>
<td>AutoNumber</td>
<td>Creates a unique sequential number for each record.</td>
</tr>
<tr>
<td>Yes/No</td>
<td>This is a binary field (only two answers, Yes/No, True/False)</td>
</tr>
<tr>
<td>Lookup...</td>
<td>The lookup wizard allows you to link the field to another Table or to type in a list of your own creation.</td>
</tr>
</tbody>
</table>

- **Descriptions**, which will be displayed in the status bar in the Data view of Forms
- And the **Properties** of each field, such as how many characters can be entered (text field size), or how the data is formatted (05/05/95 or May 5, 1995).
The **Datasheet View** of a Table allows you to create and modify the data within a grid structure based on the settings in the Design View.

Vocabulary

A collection of fields make up a record. A collection of records make up a Table. A collection of Tables make up a database.

- **Field** – One column of a Table common to all the records
- **Record** – One row of a Table containing all data about a particular entry
- **Table** – One set of related data
- **Database** – Structured collection of related Tables

**Queries**

Queries show a selection of data based on criteria (limitations) you provide. Queries can pull from one or more related Tables and/or other Queries.

The **Datasheet View** of a Query looks like a Table. All data added or modified in a Query, will be saved in the Table. The **Design View** is where the structure of the Query is created. This is where we choose the record sources and fields, and set the sort order and criteria.
**Forms**
Most Forms display one record at a time, in a formatted user-friendly environment. You can build your Form so it will display multiple records. As you develop Forms you can create navigation buttons, insert graphics, and change the colors to display everything consistently. Forms have three basic views: Design View, Layout View and Form View.

Your record source can be a Table or Query. If we want to *all* the patients use the Table; if we only want to see Dr. Edward’s Patients, use a Query.

The data entered or modified in a Form is automatically saved to the Table. The Table is the true location of the data; the Form is a "pretty" way to view/modify/create the data.

If you would like to view more than one record at a time you may use a "Multiple Items" Form, or a "Split Form". Multiple Items, sometimes called a Tabular or Continuous Form, shows multiple formatted records. Split Forms show the Form view and a datasheet view in the same window.
For the Basic Workshop we will use the AutoCreate buttons to make our Forms. Once the Form is created, you can use the Layout View to change the placement and size of the fields. In the Intro to Forms and Reports workshop we will learn to build these database objects in the Design View.

As your Forms become more involved, you can use the Design View to add objects like command buttons to move between records, Forms and Reports.

Reports
Reports are designed to create an organized output of data from your database. With a Report, you can group and summarize information. You can't edit the data in a Report, but if you make the modifications in the Table, Query, or Form you will see the results when you open the Report again. Reports have four basic views: Report View, Print Preview, Layout View, and Design View.

Example of Grouping
For the Basic Workshop we will use the wizard and AutoCreate buttons to make our Reports.

The Print Preview and Report View allow you to view how the data falls into the Report.

- The Print Preview will show you how the data falls on the page, and how it will appear when printed.
- The Report view lets you see a continuous flow of the data without page breaks.

The Design View and Layout View allow you to resize and move the fields.

- The Design View allows you to add objects (like text boxes that contain formulas).
- The Layout view allows you to resize the field and see the data at the same time.
Class Exercise

Create the Database
1. Open Access
2. Choose Blank Database
3. Use the FILE NAME: Patient Appointments
4. Close the new Table that is automatically created

Create the Patients Table
1. Click on the Create Tab and choose TABLE DESIGN
2. Type the first Field Name: Pt Med Rec #
   a. Data Type: Text
   b. Description: Patient's Medical Record Number
3. Enter in the rest of the fields (descriptions not necessary):

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pt Med Rec #</td>
<td>Text</td>
<td>Patient's Medical Record Number</td>
</tr>
<tr>
<td>Pt First Name</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Pt Last Name</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Pt Prim Phone #</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Pt Birth Date</td>
<td>Date/Time</td>
<td></td>
</tr>
</tbody>
</table>
4. Set the Pt Med Rec # to be the key
   a. Click on the big yellow key on the toolbar
5. Save the Table as Patients

Entering First Record
1. Turn to theDatasheet View
2. Enter our first Med Rec #: 123-456
3. Press tab move to the next field

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Phone</th>
<th>Pt Birth Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>123-456</td>
<td>Shaun</td>
<td>Fuller</td>
<td>3525551234</td>
<td>1/1/1</td>
</tr>
</tbody>
</table>
   a. First Name: Shaun
   b. Last Name: Fuller
   c. Birth Date: 1/1/1
      – If you set it as a DATE/TIME field Access will add in the "200" for 2001
   d. Phone #: 3525551234
      – No dashes
Exit the Database
1. Exit the database, Access will probably not ask you to save
   a. But it did save the record, it does so automatically.
2. Open your database from the desktop
3. Open the table (double-click) from the navigation pane

Rearrange Fields
1. In Design View, move Pt Birth Date above the Pt Phone
2. Switch to the Data View and Enter the next record

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Birth Date</th>
<th>Pt Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>789-123</td>
<td>Jacob</td>
<td>Smith</td>
<td>2/2/92</td>
<td>3525554321</td>
</tr>
</tbody>
</table>

Adding Fields
1. In Design View, create **Pt Gender**, text field, above Pt Birth Date
   a. Insert Rows from Design Tab, or from the right-click menu
2. In Data View Enter "Male" (the whole word) for Shaun and Jacob
3. Enter a new record

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Gender</th>
<th>Pt Birth Date</th>
<th>Pt Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>555-555</td>
<td>Jennifer</td>
<td>Underwood</td>
<td>F</td>
<td>March 3, 1983</td>
<td>352-555-5555</td>
</tr>
</tbody>
</table>
   a. Enter Gender as just one character
   b. Enter birth date as March 3, 1983; it should change to 3/3/1983
   c. Type in the hyphens for the phone number

Modify Field Properties – Field Size
1. In Design View, set **Field Size** of Gender to be 1
   a. When you save you will get an error message saying data may be lost click **Yes**

   ![Microsoft Access Error Message]

   b. Data is lost, our Male entries should now only read M
Modify Field Properties – Format

1. In Design View, set the **Format** of the Birthday to be a Medium Date
   a. Notice there is no "field size" for a date field, because it doesn’t matter how many characters you type in, as long as it’s a valid date.

Modify Field Properties – Input Mask

1. In Deign View, set an **Input Mask** for the Phone Number
   a. In Field Properties, click in the Input Mask line; click the Build button (…)
   b. In the Input Mask Wizard, Phone Number is already selected. Click FINISH.
   c. Save and View Results

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Gender</th>
<th>Pt Birth Date</th>
<th>Pt Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>123-456</td>
<td>Shaun</td>
<td>Fuller</td>
<td>M</td>
<td>01-Jan-01</td>
<td>(352) 555-1234</td>
</tr>
<tr>
<td>339-852</td>
<td>Jennifer</td>
<td>Underwood</td>
<td>F</td>
<td>03-Mar-83</td>
<td>352-555-5555</td>
</tr>
<tr>
<td>839-482</td>
<td>Jacob</td>
<td>Smith</td>
<td>M</td>
<td>02-Feb-92</td>
<td>(352) 555-4321</td>
</tr>
</tbody>
</table>

2. Fix Jennifer’s Phone Number

Enter a New Record

1. Enter a new record

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Gender</th>
<th>Pt Birth Date</th>
<th>Pt Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>527-594</td>
<td>Doris</td>
<td>Jones</td>
<td>F</td>
<td>4/4/74</td>
<td>3525555432</td>
</tr>
</tbody>
</table>

2. Close the Table

3. Open the Patient’s Table

<table>
<thead>
<tr>
<th>Pt Med Rec #</th>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Gender</th>
<th>Pt Birth Date</th>
<th>Pt Phone</th>
</tr>
</thead>
<tbody>
<tr>
<td>123-456</td>
<td>Shaun</td>
<td>Fuller</td>
<td>M</td>
<td>01-Jan-01</td>
<td>(352) 555-1234</td>
</tr>
<tr>
<td>339-852</td>
<td>Jennifer</td>
<td>Underwood</td>
<td>F</td>
<td>03-Mar-83</td>
<td>352-555-5555</td>
</tr>
<tr>
<td>527-594</td>
<td>Doris</td>
<td>Jones</td>
<td>F</td>
<td>04-Apr-74</td>
<td>(352) 555-5432</td>
</tr>
<tr>
<td>839-482</td>
<td>Jacob</td>
<td>Smith</td>
<td>M</td>
<td>02-Feb-92</td>
<td>(352) 555-4321</td>
</tr>
</tbody>
</table>

Create Female Patient’s Query

1. Go to the Create Tab and choose QUERY DESIGN
2. ADD Patients to the Query, close the Show Table box
3. Add Patient’s Name and Gender by double-clicking on the fields
4. Datasheet View

<table>
<thead>
<tr>
<th>Pt First</th>
<th>Pt Last</th>
<th>Pt Gender</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shaun</td>
<td>Fuller</td>
<td>M</td>
</tr>
<tr>
<td>Jennifer</td>
<td>Underwood</td>
<td>F</td>
</tr>
<tr>
<td>Doris</td>
<td>Jones</td>
<td>F</td>
</tr>
<tr>
<td>Jacob</td>
<td>Smith</td>
<td>M</td>
</tr>
</tbody>
</table>
Customizing a Query

1. In theDatasheetview noticethesort order is byMed Rec #
2. In the Design view, set Query to **Sort by**Pt Last Name **Ascending**
3. Go to the Data View, patients should read, Fuller through Underwood
4. In the Design View, set the **Criteria**line for the Pt Gender field to be F
   a. InDatasheetview, you should only have two people: Jennifer and Doris

5. Close and save the Query as **Female Patients**

Create Patients Form

1. SelectPatients Table from left Navigation Pane so it becomes the default data source
2. On the Create Tab click on the FORM button
3. We are in the Form's Layoutview
   a. Adjust the field widths
4. Change to the "Form" view (first button on the Home Tab)
5. Create a new FEMALE patient, anyone you want
6. Open the Patients TABLE, view new person
   a. From the left Navigation Pane, double-click
7. Open the Female Patients QUERY, view new person
   a. New patient has been saved, even though the Form has not been saved
8. Close all, Save Form as "Patients"

Create Simple Report

1. Select Table from left Navigation Pane so it becomes the default data source
2. On the Create Tab click on the REPORT button
   a. In Layout View, adjust the columns to fit the data
   b. Right-click to go to the Print Preview
   c. Data sorted in the order it was created in the Table
   d. Close and Save as Patients
Create Grouped Report

1. Select Patient Table from left Navigation Pane so it becomes the default data source
2. On the Create Tab click on the REPORT WIZARD button
   a. Step 1 (Select fields)
      – Use double arrow (>>) to move over all fields
   b. Next Step 2 (Grouping) -
      – Group by Pt Last Name,
      – Grouping Options "1st Letter"
      – Group by Pt Birth Date twice
      – Grouping Options by Month & by Week
      – Ungroup all fields (no blue in the left side)
      – Group by Gender
   c. Next Step 3 (sorting)
      – Sort by Last Name and First Name Ascending
   d. Next Step 4 (layout) - Choose Outline 1
   e. Next Step 5 (style) - Choose Office
   f. Next Step 6 (saving) - Patients by Gender
3. Right-click and go to the layout view, adjust the birthday field
4. Close and save the Report

Create Appointments Table

1. Click on the Create Tab and choose TABLE DESIGN
2. Create Table as shown here
3. Set Appt ID # to be the Primary Key

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appt ID #</td>
<td>AutoNumber</td>
</tr>
<tr>
<td>Pt Med Rec #</td>
<td>Text</td>
</tr>
<tr>
<td>Appt Doctor</td>
<td>Text</td>
</tr>
<tr>
<td>Appt Date</td>
<td>Date/Time</td>
</tr>
<tr>
<td>Appt Time</td>
<td>Date/Time</td>
</tr>
<tr>
<td>Appt Reason</td>
<td>Text</td>
</tr>
<tr>
<td>Appt Type First</td>
<td>Yes/No</td>
</tr>
<tr>
<td>Appt Type Follow-up</td>
<td>Yes/No</td>
</tr>
<tr>
<td>Appt Type Emergency</td>
<td>Yes/No</td>
</tr>
<tr>
<td>Appt Location</td>
<td>Text</td>
</tr>
</tbody>
</table>

Create Lookup Location

1. Change the Data Type for Appt Location to be LOOKUP WIZARD
   a. Step 1 - I will type in the values I want
   b. Next Step 2 – Mag Ctr, Med Plaza, South Tower
   c. Next Step 3 – Label Appt Location
   d. Finish
2. Appt Location field type still says TEXT
   a. View Lookup tab in the properties at the bottom of the window
Create Lookup Pt Med Rec #

1. Change the Data Type for Pt Med Rec to be LOOKUP WIZARD
   a. Step 1. I want the lookup column to look up the values in a Table or Query
   b. Next Step 2. (Patients Table is already selected)
   c. Next Step 3. Bring over: Pt Med Rec, Pt Last Name, Pt Birth Date
   d. Next Step 4. Sort by: Pt Last Name, Pt Birth Date
   e. Next Step 5. UNCHECK the hide key column
   f. Next Step 6. "Choose a field that uniquely identifies the row". (Pt Med Rec #)
   g. Next Step 7. Label of Pt Med Rec is fine, click Finish
   h. Click Yes to the warning message "The Table must be saved before the Relationship can be created"

Add an Appointment

1. In Datasheet view enter a new record
   a. Med Rec #: 123-456
   b. Appt Doctor: Jekyll
   c. Appt Date: 10/17
   d. Appt Time: 2p
   e. Appt Reason: Mood Swings
   f. Check Appt Type First
   g. Appt Location: Choose from list

Modify Appt Table

1. Change CAPTION property for the check boxes so you can read title

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Caption</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appt Type First</td>
<td>First Appt</td>
</tr>
<tr>
<td>Appt Type Follow-up</td>
<td>Follow-up</td>
</tr>
<tr>
<td>Appt Type Emergency</td>
<td>Emergency</td>
</tr>
</tbody>
</table>

2. Change Appt Time FORMAT property to remove the seconds
Create Schedule Query with Multiple Tables

1. Go to the Create Tab and click the **Query Design** button
2. Add both Tables and close the show Table window
   a. From the **Appointment** Table Double-click on **Pt Med Rec #**
   b. From the **Patient Table** Double-click on **Pt First Name** and **Pt Last Name**
   c. From the **Appointment** Table Double-click on **Appt Doctor**, **Appt Date**, **Appt Time**, and **Appt Reason**
3. Add a new record in the Datasheet view
   a. Select the Med Rec for Ms Underwood
   b. Change Jennifer to Jenny
   c. Set the Doctor, Date, Time, and Reason

<table>
<thead>
<tr>
<th>Pt Med Rec</th>
<th>Pt First Name</th>
<th>Pt Last Name</th>
<th>Appt Doctor</th>
<th>Appt Date</th>
<th>Appt Time</th>
<th>Appt Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>339-852</td>
<td>Jenny</td>
<td>Underwood</td>
<td>Scholls</td>
<td>8/29/2015</td>
<td>2:00 PM</td>
<td>Foot Oder</td>
</tr>
</tbody>
</table>

4. Close and Save Query as **Schedule**

Create Patient Appointment Form

1. Go to the Create Tab and click the **FORM WIZARD**
   a. Choose the Table: Patients
      – Use the Double Arrow to bring over everything (>>)  
   b. DO NOT CLICK NEXT
   c. Choose Table: Appointments
      – Bring over: Doctor, Date, Time, Reason
   d. Click FINISH - We are skipping the rest of the steps

Using Patient Appointments Form

1. Click in the Pt Last Name field
   a. Click the binoculars to FIND (or press Ctrl-F)
   b. Type in Underwood
   c. Schedule another appt for Ms Underwood

2. Create a new Patient
   a. Schedule them for an appointment

3. Close and Save the Form
View the Final Results
1. View each object in the database
   a. Your Tables
   b. Your Queries
   c. Your Reports

Backing up Database
1. From the File Tab choose Info
   a. Choose Compact and Repair
      – You should do this every time it crashes, or begins to run slowly, or starts acting funny, or before you share it with me
2. From the File Tab choose Save & Publish
   a. Under advanced choose Back up Database
      – You should do this on a regular basis, but definitely before you make any major changes, or before you share it with me
3. Exit Access
   a. Right-Click on File, Choose "Send to Compressed Zipped Folder"
      – If you would like to email yourself the file, email the "Zipped Folder"
      – The Access Database inside the zipped folder is READ ONLY, meaning you cannot make changes to it. If you want to make the file editable, you will need to drag it out of the zipped folder.

Congratulations, you now know enough to be dangerous.

For more in depth instructions, including the reasoning for the exercises see the "Instructors Notes" on our webpage:  http://training.health.ufl.edu/access_handouts.aspx